Answer Key of Sample Papers

SAMPLE QUESTION PAPER-1

SECTION-A : OBJECTIVE TYPE QUESTIONS

Ans.1.

Ans.2.

Ans.3.

Ans.4.

Ans.5.

(i) (a) natural resources
(iii) (b) Viruses
(v) (b) Eustress

(@) (c) Open office writer
(#ii) (d) Operating System

(v) (b) auditory

(vi) (c¢) Internet Service Provider
(@) (c) Assistive technology
(#77) (d) All of these

(v) (d) Templates

(@) (c) Report

(#ii) (d) Two

(v) (b) IRCTC

(i) (d) All of the above

(#ii) (a) Merge Cells

(v) (b) Duplicate values
(vi) (d) Both (a) and (b)

(ii) (b) de-stressing
@iv) (¢) Icons
(vi) (a) Self-motivation

(ii) (c) taskbar
@v) (b)in

(@) (b) Cell
@) (b) Graph
(vi) (c) Insert
(@) (a) .ODS
(vi) (a) Tables
(vi) (a) Tools
(@) (b) Field
@) (a) Shift

SECTION-B : SUBJECTIVE TYPE QUESTIONS

Ans.6.

Ans.7.

Ans.8.

Ans.9.

1. Determined
2. Confident

A file is a named collection of information stored on a computer and can be a text document,
an image, a video, or any other type of digital content. A folder, a directory, is a container for
files and other folders to organize and manage digital content on a computer.

The word modem is derived from its function modulator/demodulator. Modem is a device
that converts digital computer signals into analog signals that can travel over telephone lines.
It also reconverts the analog signal to digital signals at the receiving end.

A blog can be used to convey messages about personal events, worldwide happenings,

announcements, news, reviews etc. The topic of the blog can be anything from personal to
professional. A blogger can frequently update information related to his or her interest or
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Ans.10.

Ans.11.

Ans.12.

Ans.13.

Ans.14.

Ans.15.

Ans.16.

Ans.17.

(68)

activities, express his ideas or opinions or share his knowledge by writing articles on
specific topics.

The performance of a computer can be increased by removing any extra files such as
temporary files and images. We can use some disk cleaner software, which helps us clean
up the unnecessary files.

A template is a model document that is used to create other documents. All documents in
LibreOffice are based on templates. If you do not specify a template when you start a new
document, by default blank template is used.

(1) Data Definition Language (DDL) is a language that enables a user to create, modify
and work with the structure of the database. For, eg., CREATE TABLE.

(2) Data Manipulation Language (DML) is a language that enables a user to access or
manipulate data in a database. The DML commands help users to query and manipulate
data in the existing database. For, eg., SELECT.

The character formatting options are —
(1) Font — To change the font of the Character selected we can use this formatting option.

(2) Size of the text — The size of the text can be increased or decreased as per the
requirement.

(3) Bold — The Bold option can be applied to emphasize/highlight the selected character.

Data consolidation is a feature that allows you to collect data from different worksheets to
one single sheet in the same workbook. This feature also allows the user to perform
operations like sum, average, max, min, product, etc on the data to be consolidated.
Grouping means to group multiple objects together to be treated as a single unit. Thus,
grouping allows us to perform various operations like increasing or decreasing the size,
changing the position of the grouped objects all at once.

(@) Peer to Peer (P2P) architecture Network in which all the computers have an equal
status is called peer to peer network. Generally, in such a network, each terminal has an
equally competent CPU.

(i7) DBMS - Database Management System is a computerized record keeping system that
enables to create, store, modify, and extract information from a database.

(#7ii) Primary Key — A primary key is a unique value that identifies a row in a table. A
primary key is indexed in the database making it faster for the database to search for a
record.

(iv) Foreign Key — The foreign key identifies a column or set of columns in one table that
refers to a column in another table. In other words, we can say that the primary key field
of one table is also often present in second table and so it becomes foreign key of the main
table.

The following types of Styles are supported by Writer—
(1) Page Styles — This includes margins, headers and footers, borders and backgrounds.

(2) Paragraph Styles — This controls the total appearance of the paragraph such as text
alignment, tabs, line spacing, borders and even character formatting.

R.K. PUBLICATIONS HOUSE




Ans.18.

Ans.19.

Ans.20.

Ans.21.

(3) Character Styles — This affects only the selected text within a paragraph, font and
size of the text, or Bold, Italic and Underline formats.

(4) Frames Styles — These are used to format the frames around the graphics or text, it
also includes wrapping text, borders, backgrounds and columns.

(a) CREATE TABLE, WORKER (WID INTEGER, WNAME VARCHAR (20), WDESIG-
NATION CHAR (10), WCITY VARCHAR (30), WPHONE CHAR (10));

(b) SELECT * FROM WORKER;

(¢) SELECT * FROM WORKER WHERE WCITY="DELHI";

(d) Primary Key — A primary key is a unique value that identifies a row in a table. A
primary key is indexed in the database making it faster for the database to search for a

record. The primary key constraint can be applied on one or more than one columns
together.

The following precautions must be taken to improve online security—

(1) Keeping your Username and Password Private

Never save your username or password on your devices which are used in shared
environment such as cyber cafe, offices, labs etc. Browsers can also save your personal
data on the local computer that can be used by another person using the same computer.
(2) Registering with Website

Always read the privacy statement of policy whenever you register with outside, the
statement of policy will include information about how the website use personal data.
(3) Do not Share Personal Information

Some websites require you to fill out forms containing field such as name, gender, age,
email ID School, college, company, etc. Be cautious while filling out such forms the
search and verify if it is a trustable website as your information could be used by
unauthorised users.

(4) Secured Transactions

If you to do online shopping for transactions, website stores even your credit card or net
banking details as well as your personal information your credit card number, account

details, etc. This information can be tracked and used by unauthorised user known as
hackers may misuse this information.

(a) =Sum(B3:E3) (b) Sort
(c) =MAX(BS5:E5) (d) =AVERAGE(B3:B6)
(e) =C5-C4

Follow the given steps for creating a table in LibreOffice—
e Position the insertion point where you want the table to appear.
e Choose Table > Insert Table option. This will display the Insert Table dialogue box.

e Enter the number of rows and columns for the table in the Number of Columns and the
Number of Rows boxes.

e Click on Insert, the table will be created with the columns and rows specified.
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SAMPLE QUESTION PAPER-2

SECTION-A : OBJECTIVE TYPE QUESTIONS

Ans.1.

Ans.2.

Ans.3.

Ans.4.

Ans.5.

(@) (a) Inseparable (@) (b) self regulation
(#ii) (b) Adware (iv) (a) notification area
(v) (a) Bad (vi) (¢) Self-motivation
(i) (c) Firefox (@) (b) evacuation

(#ii) (d) modem (@iv) (a) Client server

(v) (b) word press (vi) (a) Anti-virus

@ (c)Cul +P (#1) (a) Text wrapping
(#ii) (¢) Format @v) (d) cell

)@= (vi) (a) drawing/shapes
(@) (d) All of these (ii) (c) Formula

(iii) (a) Tools

(@) (¢) both (a) and (b)

(v) (b) Column

(vi) (c) Both (a) and (b)

(@) (a) Primary Key

(@) (b) Local Area Network

@) (c) 4 (iv) (d) Database Servers
(v) (b) 4 Bytes (vi) (a) Field

SECTION-B : SUBJECTIVE TYPE QUESTIONS

Ans.6.

Ans.7.

(70)

The various elements of a communication cycle are:

Sender : the person beginning the communication.

Message : the information that the sender wants to convey.

Channel : the means by which the information is sent.

Receiver : the person to whom the message is sent.

Feedback : the receiver’s acknowledgement and response to the message.
Goal setting is a very essential factor in your life. The SMART GOALS are—
S — Specific

M — Measurable

A — Achievable (Breaking down big goals into smaller parts will make the goal achievable)
R — Realistic T — Time bound
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Ans.8.

Ans.9.

Ans.10.

Ans.11.

Ans.12.

Ans.13.

Ans.14.

Ans.15.

Sustainable development can happen only when each one of us works towards it. One has
to become a responsible environment citizen who can protect the environment through
our efforts, who can help others to get quality education, by reducing inequalities in the
society etc.

Self motivation is a factor that develops an inner urge to do something, achieve goals
without any external pressure in an individual. It is an inbuilt life skill and may be developed
further as per requirement of an individual. Self motivation can be developed by—

(a) Being positive and having positive attitude towards life.
(b) Looking into past experiences where you have achieved success

Cultural barriers arise due to ethnic, religious and social differences which often create
misunderstandings during the process of communication. These differences can also affect
ones perception and create confusion while understanding the message. For overcoming
cultural barriers both the parties involved in the communication must get familiar to each
other’s culture and respect their culture, religion and ethics.

An absolute hyperlink will stop working only if the target is moved. A relative hyperlink
will stop working only if the source and target locations change relative to each other.
Suppose, if you have two spreadsheets in the same folder linked to each other and you
move the entire folder to a new location, a relative hyperlink will not break a link.

Online shopping is a form of e-commerce (Electronic commerce) where customers can
buy or sell goods over the internet. Customers need to have an active internet connection
for giving goods or services offered by seller, customers can pay online using a credit/
debit card or by internet banking. These transactions are called online transactions.

Online shopping could be useful in situations when—

(1) Customer does not have sufficient time to visit the store.

(2) Visiting a store is more expensive than purchasing a product online.

(3) A product or service that is not available in the local market but is available online.
(a) Document Template

(b) Mail Merge

(a) Web Server — It is a computer that stores websites and their related files and other
computers connected to it through internet can access these files.

(b) Dial-up - This kind of internet access uses the facilities of the Public Switched
Telephone Network (PSTN) to establish a connection to an ISP for accessing internet.
Dial up connections are extremely slow so hardly used now a days.

The workstation should—

(1) Provide sufficient space for the user to alter position comfortably.

(2) Provide adequate lighting.

(3) Have windows fitted with adjustable covering to alter the sunlight level.

(4) Be spacious enough when workstation is shared by more than one person.
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Ans.16.

Ans.17.

Ans.18.

Ans.19.

Ans.20.

Ans.21.

(72)

To insert an image in the document follow the given steps—
e Click in the document where you want the image to appear.
e Choose Insert > Image from the Menu Bar.
e In the Insert Image dialogue box as shown in the figure given below, navigate to the file
to be inserted then select it and click on Open.
o At the bottom of the dialogue box there is an option called Link. Select Link for inserting
the image into your document as a link.
She can use Table feature for making the course of the subject Chemistry. The steps to
insert a table are as follows —
e Position the insertion point where you want the table to appear.
e Choose Table > Insert Table option. This will display the Insert Table dialogue box.
e Enter the number of rows and columns for the table in the Number of Columns and the
Number of Rows boxes.

e Click on Insert, the table will be created with the columns and rows specified.
(a) Goal Seek — Goal seek is one of the powerful feature of LibreOffice Calc. It is a
feature which reverses the usual order for a formula that is we run a formula to get the
result with certain arguments whereas with Goal seek we work with the output to see what
values were used to get the result.
(b) Scenarios — Scenarios is a set of values that can be used within your calculations. You
can assign a name to every scenario in your sheet. Several scenarios can be defined in a
single sheet with different names and different cell values.
Scenarios are basically a tool to test “what if”” questions and a defined scenario is named,
can be edited and formatted separately. Once defined, it can be chosen from a dropdown
list in the Navigator or the Title bar of the Scenarios.
DBMS - Database Management System is a computerized record keeping system that
enables to create, store, modify, and extract information from a database. A database is a
structured collection of data stored in computer memory using tables, records and fields
so that users with the help of various applications can easily add, delete, edit, search and
manipulate the data.
Advantages of DBMS are —
Database and its components can be created and modified as per requirement.
Minimal data repetition to increase data inconsistency.
(a) =SUM(C2:E2) (b) =AVERAGE(C2:E2)
(c) =MAX(C2:C6) (d) =MIN(D2:D6)
The steps to share the spreadsheet are as follows—

Open a spreadsheet to be shared and place it on network location so that multiple users can

use it simultaneously.

e Click on Tools > Share Spreadsheet in the menu bar.
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¢ A dialogue box will appear as shown in the figure.

e Check the option “Share this spreadsheet with other users” available at the top of the
dialogue box.

e Click OK.

SAMPLE QUESTION PAPER-3

SECTION-A : OBJECTIVE TYPE QUESTIONS
Ans.1. (i) (¢) multi-user (@) (c) Yoga

(iii) (b) Entrepreneur should not think optimistically about the future of the business
@iv) (b) Yotemp%
(v) (a) Dependent
(vi) (d) Discourages welfare of the society
Ans.2. (i) (a) Sticky (@) (a) Filtering
(@ii) (b) Open Office Writer @iv) (a) Sheetl
(v) (c¢) Keep ratio
(vi) (b) Data Redundancy

Ans.3. (i) (b) Anchoring @) (d) Length
(#ii) (a) SoundSentry (iv) (b) False
(v) (a) Comments (vi) (b) value
Ans.4. (i) (d) both (a) and (b) (ii) (d) Table of Content
(iii) (d) 50 @iv) (d) less sleep
(v) (b) Internet (vi) (a) Cell Reference

Ans.5. (i) (b) Design view
(i) (c) Bharat Sanchar Nigam Limited
(iii) (b) Data Consolidation
(iv) (a) Flat File
») (b) 10
(vi) (d) P2P

SECTION-B : SUBJECTIVE TYPE QUESTIONS

Ans.6. The advantages of the ability to Work Independently:
e  Ensures greater learning.
e  Individuals feel more empowered and responsible.
e [t provides flexibility to choose and define working hours and working mechanisms.
e  Failure and success of the task assigned are accounted by individuals.
e Individuals become assets to organizations, groups and nations at large.

e [t ensures creativity and satisfaction amongst individuals.
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Ans.7.

Ans.8.

Ans.9.
1.

Ans.10.

Ans.11.

(74)

The causal agents of stress are:

Mental : Mental stress may occur due to conflicts, frustration, internal or social pressure
etc.

Physical : Physical stress occurs due to overexertion, some kind of illness or failure to get
enough sleep

Social stress is caused due to external factors such as disturbed relationships, conflicts
with others, death or illness in family etc.

Financial : Financial stress occurs due to money problems.

A disk defragmentation removes all unnecessary information that slows down the computer.
It should be done at regular intervals which helps the disc space to be used at an optimal
level.

Myths about Entrepreneurship are:

The misconception is that every business idea needs to be unique or special : Each
entrepreneur saw customer demand and brought a new idea into their business. A person
can take an idea that is already there in the market and do something different with it.

The misconception we have is that a person needs a lot of money to start a business
: Every business does not need a lot of capital to start. Depending on how much more. you
have or can borrow, you can put that into business with that much money. Once you make
more money, you can put that into your business to make it bigger.

A misconception we have is that only a person having a big business is an
entrepreneur : No business is big or small. If a person is running a business to fulfill a
customer’s need, they are an entrepreneur. Most businesses start small. It becomes big
with hard work and creativity.

A misconception we have is that entrepreneurs are born, not made : Only some people
have the talent for doing business. An entrepreneur is a person who does whatever it takes
to make the business successful.

Being an entrepreneur starts with a way of thinking. You must believe that anything is
possible and it shall be achieved. It starts with thinking of an idea that you want to work
on, making it different: (Any two out of four Myths can be explained)

Roles of Entrepreneurs are:
e Coordinating role

e Agent’s role

e Innovator’s Role

e Risk assumption role

e Imitating role

e Capital formation role:

e Employment Generation role

A template is a model document that is used to create other documents. The templates are
used to create documents due to following reasons:
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Ans.12.

Ans.13.

Ans.14.

Ans.15.

Ans.16.

Ans.17.

o [t saves time and effort required for formatting.

e It increases the attention of the audience by providing preformatted documents.
Macros are used to perform different types of operations in a Spread sheet:

e Formatting settings to be applied repeatedly in a spreadsheet

e Sorting Data

e Applying any Mathematical functions/formulas

Hyperlinks can be used in Calc to jump to a ‘different location from within a spreadsheet:
and can lead to other parts of the current file, to different files. It can be stored wthin a file
as either Relative or Absolute hyperlinks.

Numeric datatypes are: Tinylnt, Smalllnt, Integer. Bigint, Decimal, Real, Float, Double
and Boolean.

Alphanumeric Datatypes are: Char(fix), Varchar, Varcharignorecase and
Longvarchar(Memo).

Filter Keys is an accessibility function that tells the keyboard to ignore brief or repeated
keystrokes, making typing easier for people with hand tremors.

ToggleKeys is an accessibility function which is designed for people who have vision
impairment or cognitive disabilities. When ToggleKeys is turned on computer emits sound
cues when the locking keys (Caps Lock, Num Lock, or Scroll Lock) are pressed.

Online shopping could be useful in situations when:

e A customer does not have sufficient time to visit stores.

e Visiting a store is more expensive than purchasing a product online.

e Two popular online transaction websites are:

Flipkart an online shopping portal for buying consumer products.

EBay, an online portal for buying and selling goods.

1. Scenarios : Scenarios is a tool to test ‘what- if” questions. Each scenario is named, and
can be edited and formatted separately. It is essentially a saved set of cell values for your
calculations. You can easily switch between these sets using the Navigator or a drop-
down list which can be shown beside the changing cells.

2. Goal Seek : It is used to calculate a result based upon existing values. Using Goal Seek
option under Tools menu, we can discover what values will produce the result that we
want.

3. Solver : It is more elaborated form of Goal Seek The difference is that the Solver deals
with equations with multiple unknown variables. It is specifically designed to minimize
or maximize the result according to a set of rules that we define.

4. Subtotal : SUBTOTAL is a function listed under the Mathematical category when you
use the function Wizard (Insert > function). Because of its usefulness, the function has a
graphical interface.

SUBTOTAL totals/adds data arranged in an array that is, a group of cells with labels for
columns and/or rows. Using the Subtotals dialog, you can select arrays, and then choose a
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Ans.18.

Ans.19.

Ans.20.

Ans.21.

(76)

statistical function to apply to them. For efficiency, you can choose up to three groups of
arrays to which to apply a function.

(7)) Merge Field : A merge field is where you want to insert the information from a data
source into a main document. Merge fields appear with chevrons (« »).

(i7) Data Source : Data source is a file that contains the names and addresses or any other
information that vary with each version of a mail-merge document.

(7if) Main Document : Main document is the document which contains text and graphics.
It may be a formal or an official letter.

(iv) Two types of data on which mail merge can be applied are Labels and Letters.
(A) Four fields and four records are there in table Sales.

(B) SQL commands:

(i) select Sale_Id, Price from Sales where Discount > 1000;

(i) select * from Sales order by Prod_Name;

(iii) select Prod_Name, Price-Discount as sales price from Sales;

(A) A database management system is a software package with computer programs that
controls the creation, maintenance, and use of a database. It allows organizations to
conveniently develop databases for various applications.

(B) Two databases are:
(a) Microsoft Access
(b) MySQL

(c) Open Office Base

(C) 1d field will be suitable for Primary Key.
(D) Yes. we can make more than one column as a primary key in a table and it is known as
Composite Primary Key.

(A) Networks in which all computers have an equal status are called peer to peer networks
whereas in which certain computers have special dedicated tasks, providing services to
other computers (in the network) are called client server networks.

(B) Expand the following terms:
(i) Wireless Access Point

(7)) WWW (World Wide Web)

(C) Advantages of Networking are:

Data Sharing : One of the most important uses of networking is to allow the sharing of
data.

Files Transfer : Users can send text files, spread sheets, documents, presentations, audio
files, video files, etc. to other users.

Hardware Sharing : Hardware components such as printers, scanners. etc. can also be
shared. For example, instead of purchasing 10 printers for each user, one printer can be
purchased and shared among multiple users thus saving cost.
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Internet Access Sharing : You can purchase a single Internet connection and share it
among other computers in a network, instead of purchasing multiple Internet connection
for each computer. This is very commonly found in Internet cafe (browsing centres), schools,
colleges, companies, etc.

Usage of network based applications : Such as web browsers, email clients, chat
application, audio & video calling, etc. is another advantage.

(D) A blog is a discussion style site used by non-technical or technical users for creating
personal web pages. Blogs are similar to an online personal diary and simple to use. The
advantage of offline blog is, it can be created first and later publish the content when an
active internet connection is available.

SAMPLE QUESTION PAPER-4

SECTION-A : OBJECTIVE TYPE QUESTIONS

Ans.1.

Ans.2.

Ans.3.

Ans.4.

Ans.5.

(i) (d) All of the above (@ii) (a) Stress
@) (¢) Ctrl + C @v) (d) Startup India
(v) (b) Graphical User Interface

(vi) (b) Owning a shoe business

@) (c) Mail Merge

(ii) (d) What-If Analysis

(@ii) (b) Primary

(iv) (d) Multiple

(v) (b) Padlock sign

(vi) (b) TCL commands

@) (c) Style

(@) (c) Consolidating

(iii) (a) Table of Contents (iv) (d) Back-ends

(v) (d) OpenOffice Impress (vi) (b) Facebook

(@) (c) Cropping (i) (b) Bandwidth

(iii) (d) Client/Sever @iv) (c) Track changes

(v) (a) Sorting (vi) (a) Insert — Link

(@) (a) Shapes @it) (b) Modem

(iii) (a) Macro @iv) (a) It summarizes and prints data
(»v) (a) One to One (i) (d) All of these

SECTION-B : SUBJECTIVE TYPE QUESTIONS

Ans.6.

Two principles of effective communication are as follows:

(@) Consistency : The communication should always be planned and consistent with a
clear objective of the message being conveyed.
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Ans.7.

Ans.S8.

Ans.9.

Ans.10.

Ans.11.

(78)

(1) Feedback : The feedback provides confirmation from the recipient whether the message
is understood in the same sense as it was delivered or not

Self-management refers to the ability of managing our behaviour, thoughts and emotions
in a conscious and productive way. Employees with strong self-management skills can
achieve their goals within a time line without going through stress.

Entrepreneurs provide a large number of employment opportunities. An entrepreneur,
even at the most basic scale, employs people to manage their business activities. They
generate direct as well as indirect employment by setting up new units at small and large
scale levels.

The physical cleaning of computer is very important so as to remove dust from it. Dust
makes the computer over heated resulting in damage of its parts. While cleaning a computer
following things should be taken care of

Always use a lint-free cotton cloth to clean its components.

Never spray any liquid onto any computer component. You can spray the liquid onto a
cloth.

Always use a vacuum cleaner for sucking the dust from the computer parts. The vacuum
cleaner that plugs into the wall should not be used.

Never use any harsh object such as wire brush etc. for cleaning. Always use a cleaning
brush with soft bristles.

Avoid keeping eatables around the computer.

SMART is an acronym that stands for Specific, Measurable, Achievable, Realistic and
Timely. It incorporates all these criteria to help focus your efforts in achieving the goals.

A stands for Achievable which means that goals should be attainable and not impossible
to achieve. For achieving the goals, they can be broken into small steps for short term.

Related Theory :
Other terms of SMART are:
Specific — Coats should be specific, clear and unambiguous.

Measurable — Goals should have specific criteria to measure the progress towards their
accomplishments.

Realistic — Goals should be realistic within reach and most importantly you should be
willing and able to work to achieve them.

Timely — For achieving the goals there should be a clearly defined timeline with both
starting and target dates.

Style in a word processor provides a consistent appearance to the document. These are
helpful in long documents such as thesis, manuscripts, etc. Using Styles you can format
your document by quickly applying multiple formatting settings to portions of the document
It also helps in building a table of contents.
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Ans.12.

Field Record

A field contains only one A record is a combination of related fields.
type of informations.

It contains information about one It represents a complete unit of information.

aspect of a complete record.

Ans.13.

Document Hyperlink in a spreadsheet is defined as a reference to any location, webpage
or a document that we can access by clicking the link. Using these links you can combine
text as well as other spreadsheet objects such as charts, sheets, images etc.

Ans.14.
LAN WAN
LAN stands for Local Area WAN stands for Wide Area Network Area
Network Network
It is a small computer network confined | It is a network of computers that are
to a local area such as one office or a geographically apart such as cities.
building etc. countries etc.
Ans.15 The comments in a worksheet are added when you are sharing a worksheet with multiple

Ans.16.

Ans.17.

Ans.18.

users. They add an extra information to a figure in a cell use to note trends, or add an
action note. These comments only show the suggested changes in a worksheet which the
user can accept or reject as required. The comments are temporary and can be edited or
deleted from the sheet. These refrain the user from making any kind of permanent changes
in sheet.

Online transaction is a payment method in which money is transferred electronically over
the Internet. It is also known as e-payment.

A. After reviewing, the sheets can be brought together by merging them.

B. To merge the sheets, click on Edit ’! Changes ’! Merge Document.

C. The merging of sheets is useful in situations when data is split into multiple sheets or
multiple reviewers have given edited documents. The data from these sheets are then
required to put together into a single worksheet which is accomplished by merging the
sheets. D. By default, Calc provides three worksheets in a workbook.

(A) She can use Crop feature of word processor to remove that unwanted part from the
image.

(B) The drawing objects can be combined together by grouping. This feature will treat all
the separate objects as one and whatever functions are performed will be applied on all of
them.

(C) Text Wrap feature can be used to keep the image between the text. The text is placed
around the image.
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Ans.19.

Ans.20.

Ans.21.

(D) An anchor is a symbol that appears when image or any other object is inserted in the
document. It is a reference point for the vertical and horizontal placement of images.

(A) There are four fields and four records in the table.

(B) (i) SELECT ITEMNAME FROM ITEMS WHERE QUANTITY < 30;
(ii) UPDATE ITEMS SET PRICE = PRICE + 0-5 * PRICE;

(@i7) INSERT INTO ITEMS VALUES (1290456, Glucose Biscuit, 15.00, 40);
A.There are three methods to create table in OpenOffice Base These are

(a) Using Table wizard

(b) Using Datasheet view

(c) Using Design view.

B. Database is a collection of interrelated tables whereas a table is a component of database
that consists of all the information and data organized in rows and columns.
C. The absence of value or an unknown value in a field is called Null value.

D. A field which uniquely identifies each record in a table is called a primary key. For e.g.
Book ID, Product_No, etc.

(A) While chatting with people using any instant messenger, one should follow some
basic rules and etiquettes for chatting. Some of them are as follows

Start your conversation with small greeting.

Keep your messages short and sweet

Use of Caps Lock should be avoided as it is equivalent to shouting.

Always end your conversation with short closing message, e.g., bye, take care etc.
[Note : Write any 2 points]

(B) Instant messaging apps that can be used by them are WhatsApp, Facebook Messenger,
Google Hangouts, Slack.

(C) Apart from computers they would require a webcam, microphone, speaker and
headphone for Video Conferencing.

(D) Email can be used to send messages and files in form of attachments, over the Internet.

SAMPLE QUESTION PAPER-5

SECTION-A : OBJECTIVE TYPE QUESTIONS

Ans.1.

(80)

(1) (d) Motivating oneself and setting goals.

(@) (b) Avoiding risks

(#ii) (b) Copying files from hard drive to pen drive.
(iv) (a) Extrinsic

(v) (@) Operating system

(vi) (b) The price of the product goes high
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Ans.2.

Ans.3.

Ans.4.

Ans.5.

@) (a) Text style (it) (a) Scenario

(iii) (b) Fields (iv) (b) Ease of Access
(v) (b) Available to everyone (vi) (b) Removing

(@) (b) Drawing objects @ii) (b) B5S:E15

@) (b) Ctrl + N @@v) (b) Sticky Keys
(v) (d) All of these

(vi) (b) Online transaction

(i) (b) Letter and fields

(ii) (d) Track changes

(iii) (a) Foreign

@iv) (b) Group By

(v) (c) It is the other name given to the primary key.
(vi) (c) Webpage

@) (b) Template

(ii) (d) Makes tasks complex

(>iii) (¢) > = 25 and < = 50 in the column BalStock
(iv) (a) Peer-to-peer network

) (@) 1

(vi) (b) False

SECTION-B : SUBJECTIVE TYPE QUESTIONS

Ans.6.

Ans.7.

Ans.8.

The production of any product should be according the needs of customers, which keeps
on changing from time to time. Thus an entrepreneur has to be innovative. An entrepreneur
always strives to fulfill the demands or needs of the customers by exploring new products,
ideas and innovative creations.

In SMART, ‘S’ stands for specific. It means that goals should be well defined, clear and
unambiguous. It should clearly specify what is to be achieved and accomplished. The
specific goals have greater chance of being achieved. To make a goal specific, The six
“W” questions must be taken into consideration:

What : What do I want to accomplish?

Who : Who is involved to achieve goal?

When : When should the goal be achieved?

Why : Why do I want to achieve the goal?

Where : Where is this goal to be achieved?

Which : Which are the requirements to achieve the goal?
Emotional intelligence is managed by following the three steps:

Understand your Emotions : This is done by observing oneself behaviour and by working
on things that needs to be changed.
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Rationalise : One’s behaviour should be rationalised. One should take decisions reasonably.

Practice to keep oneself calm : Keeping the body and mind calm can be practised by yoga
and meditation.

Entrepreneurs can change the way of living and work. Their ventures not only create jobs
but also conditions,, for making a wealthy society. Given below are some of the contributions
that entrepreneurs make for the society:

Entrepreneurship creates jobs.
They use their creativity and finances to introduce innovative ideas and technologies.
It helps in raising the standards of living by uplifting the earning power of people.

Successful entrepreneurs set up a role model and inspire many more for entrepreneurship.
Thus, the cycle of economic upliftment continues.

Entrepreneurs invest in community projects and social causes like public health and
education etc.

Ans.10. After you switch ON the Power button, following steps are performed by the computer:

1. POST (Power OnSelf Test) starts— It is an operation initiated by the computer after it
is turned ON but before the operating system is loaded into memory.

2. Operating System Starts : After performing POST, the computer starts the process of
booting up the operating system.

3. Welcome Screen Appears : After the booting process is complete, the monitor shows
the Welcome screen of the operating system in your computer.

4. Login Screen Appears : The login screen asks for the user name or ID and its password
to login into the computer.

S. Desktop Appears : After entering the correct ID and password, computer displays the
desktop of the operating system and allows the user To work on the computer.

Ans.11. Headings are very important in any document. Headings organise the document and increase

its readability. A document may have headings and its sub headings or a sub- sub heading,
i.e., adocument can have various levels of headings called heading hierarchy. This hierarchy
of headings specify the relationship between main heading and sub headings. It also describes
the importance of information written under different levels of headings.

Ans.12.In every spreadsheet, by default a workbook consists of at least one worksheet. You can

add new worksheets in the same workbook. Multiple worksheets are required when you
are working on large amount of data. Multiple worksheets help in organising your workbook
and make it easier to find data.

Ans.13.Advantages of databases are as follows:

(82)

Databases reduce data redundancy, i.e., duplication of data.

It controls data inconsistency which means multiple mismatching copies of same data.
It facilitates sharing of data.

It ensures that the data stored should follow the applicable standards.

It ensures data security and privacy.
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Ans.14.

Ans.15.

Ans.16.

(A) Web Client — A web client is a program on the client side of the network. It requests
and uses services provided by a web server. A web browser is an example of web client.

(B) Web Portal — A web portal is a specially designed website that provides information
from the diverse sources such as email, online forums, search engines etc. MSN, Yahoo,
India times are some examples of web portals.

Disadvantages of blog are as follows:

e Information given in personal blogs may be biased or inaccurate.
¢ Blogs can be time consuming.

e The comments written on blogs may be rude or inaccurate.

e Whatever is published in blog is available to all.

Goal Seek Solver

Goal seek is used on single variable. Solver can solve equations that use

multiple variables.

It allows to vary the values only in It allows values to vary in 200 cells.
one cell.

Ans.17.

Ans.18.

(A) It provides functions, which can be used to create formulas to perform complex
calculations on data.
e It has Macros, for recording and executing repetitive tasks.

(B) Spreadsheets are customisable so they are not user friendly and secure. Anyone can
share the worksheet by sending a simple mail to any other person.

e Data visualisation is difficult especially when there is large number of records then
scrolling up and down makes the working diffcult and time consuming.

(C) To rename a sheet double click on the sheet tab and replace the existing name.

(D) To add one more sheet right click on the sheet tab and click on Insert Sheet from the
pop-up menu.

(A) She can use Style feature of a word processor to make her work easy. A style is a
named collection of various formatting options. It is a set of formats that can be applied to
pages, text, frames and other elements of the document to quickly change their appearance.

(B) Style can be categorised as follows:

e Character style — formats a single character, word or a phrase.

e Paragraph style — formats paragraphs including font type and size

e Frame style — formats text and graphic frames

e Page style — Organizes the structure of the document and adds page numbers
e List syle — formats numbered or bulleted lists

(C) The advantages of Style are:

e It maintains consistent formatting in a document.
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Ans.19.

Ans.20.

Ans.21.

e Major formatting changes can be easily applied to multiple objects of same style.

(D) Template is a special type of document that contains formatting features like styles,
headers, footers, etc. It is used to create new documents on the basis of these formatting
features. It is like a blue print used to create new documents.

(A) ItemNo field can be set as a primary key.

The reason is that the item number is a unique data for each item in the table and the items
can be searched, viewed o the basis of the item number.

(B) (i) SELECT price FROM items WHERE ItemName = “Cold Drink”
(@) INSERT INTO items VALUES (“1163 , “Cold Coffee”, “115”)

(iiiy UPDATE items SET price = price + 25

(a) He can create either relational or Flat table.

(b) A flat file database stores data in a single table structure. A relational database uses
multiple table structures, cross-referencing records between tables. Tables in both organise
records in rows, with each column containing a single piece of data in the record.

(c) Database software has following advantages:

e It reduces data redundancy i.e. duplication of data.

o [t facilitates sharing of data among multiple users.

(d) My SQL Oracle, MS SQL IBM DB?2 are some of the commonly used database software.

(a) Instant messaging technology is a type of online chat that allows its users to exchange
messages over internet in real time. It is done with the help of some application programs
specially developed for and known as instant messengers.

(b) Some popularly known instant messaging applications are Google Hangout, Snap Chat
Skype, Facebook Messenger and WhatsApp.

(c) The key features of Instant Messaging are:
e |t is available 24 x 7.
e It can store and take backup of unlimited chat history.

(d) In Instant messaging service the messages are delivered instantly and it needs the
users to be logged on to the same server. In email the mails can be sent from one mail
server to another and the users do not need to logged on same time. The mails are stored
on the server and can be downloaded later.

SAMPLE QUESTION PAPER-6

SECTION-A : OBJECTIVE TYPE QUESTIONS

Ans.1.

(84)

() (b) Stress management (1) (b) Reduces efficiency
(#ii) (c) Viruses (iv) (c¢) Task Bar

(v) The given statement is a myth. In fact, entrepreneurs are people who made a series of
good decisions to chase success.

(vi) (¢) They do not create jobs.
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Ans.2. (i) (d) Paragraph Style @) (c) 10

(@ii) (c) Resize (iv) (a) Adrenaline
(v) (@) repeat a task (vi) (a) Record Changes
Ans.3. (i) (d) Impress (i) (b) form

(#ii) (d) Structural Query Language
(iv) Flat file
(v) (a) photos, music files, etc.
(vi) (a) WHERE
Ans.4. (i) (b) Make the current document template as default template
(i) (c¢) Relationships
(iii) (b) Absolute link
@iv) (c¢) Tables
(v) (@) Keep your message detailed
(vi) (d) HTTPS
Ans.5. (i) (¢) Virus attack
(@) (d) All of these
(#ii) (b) Data @iv) (d) Form
(v) (d) All of these (vi) (b) Style

SECTION-B : SUBJECTIVE TYPE QUESTIONS

Ans.6. Self-management skills are those characteristics that help a person to become more
productive in the workplace. Such skills includes problem solving, resisting stress,
communicating unambiguousLy, managing time, and exercising often are all key examples
of self-management skills.

Ans.7. Reward is a type of external motivation. It is also known as extrinsic motivation. Another
type of motivation is internal or intrinsic motivation which comes from within oneself.
Factors that are responsible for intrinsic motivation are love, joy, fear etc.

Ans.8. A shortcut menu provides a quick way to access the commands that are used frequently. A
shortcut menu can be invoked by right-clicking an object. These menus are context sensitive,
i.e., it depends on where your cursor is located.

The shortcut menu is of great importance because all related commands are available at
one click without having to search them from different menus. It saves our time and efforts.

Ans.9. To become a successful entrepreneur, one must have following qualities:

An entrepreneur must have strong work ethics which means that they must always be
focused towards growth of their business.

They should be passionate about their work. They must be self-motivated, self-disciplined
and committed.
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Ans.10.

Ans.11.

They must know the skill of meeting people whether they are clients, customers or
employees.

Entrepreneurship has a great role and contribution in a country’s economy. Some of them
are listed below:

1. Generates Wealth : The entrepreneurs invest money and also attract funds from other
investors. In this way the money is mobilized between investors, entrepreneurs, employees
etc, and everyone is benefited.

2. Growth of Overall Economy : The growth of their own business results in boosting
other related sectors as well resulting in growth of overall economy.

3. Increase in Per Capita Income : New startups will utilize more resources like labour,
material and capital. In return they will produce new products and services thereby adding
to national and per capita income.

Blog Newsgroup

A blog is a frequently updated online | Newsgroups are internet discussion forums

personal journal or diary. where group of people gather to discuss a

common topic.

Ans.12.

Ans.13.

Ans.14.

Ans.15.

(86)

Sizing handles are the small black boxes Located at the borders and corners of an image.
These boxes or handles allow the user to increase the size horizontally, vertically or
diagonally. When the mouse pointer is placed on one of the sizing handles, the shape of
the pointer changes to a double-headed arrow. You may then change the size by dragging
the sizing handle.

(A) Data Consolidation : It refers to the process of collecting the data from separate
sources or worksheets and integrating them into a single worksheet by applying some
formula or functions like sum, average, count etc.

(B) What - if Analysis : What-if analysis is the process of changing the values to see how
the values will affect the results of formulas in the worksheet. There are three types of
What-If analysis tools — Scenario, goal seek and solver.

Data inconsistency means multiple mismatching copies of the same data. This happens
when redundancy is not controlled. Redundancy refers to duplication of data, which can
be controlled by assigning a primary key field. It keeps check and does not allow duplicate
data. By controlling redundancy, the inconsistency is also controlled.

The World Wide Web is a set of programs, standards and protocols that allows multimedia
and hypertext files to be created, displayed and linked on the Internet. WWW is accessed
though internet.

Internet is a computer-based worldwide communication network which is composed of a
large number of smaller interconnected networks. it is an infrastructure.
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Ans.16.

Ans.17.

Ans.18.

Ans.19.

Ans.20.

Ans.21.

What-if analysis allows users to explore multiple scenario options by comparing the
outcomes of different alternative values on a single formula and ultimately make better
decision. It can benefit managers to recognize options and impact from the changing values.
(A) Multiple users can use a shared worksheet to work on it simultaneously.

(B) To check the changes done by other users he can enable the Track Changes option in
the worksheet.

(C) yes, while reviewing the changes he can accept or reject the changes.

(D) Track changes is a feature that allows the spreadsheet users to keep track of the changes
that they or other users make to a document. The users can also keep track on the comments
of other users. All changes are recorded and are visualized for the purpose of review of a
worksheet.

(A) To add text with graphics she can use the Text wrapping feature of the word processor.
The text wrap feature refers to the placement of text along with an image.

(B) To resize an image, she can click on the image. It will show small black boxes called
sizing handles on the borders of the image. Using one of the sizing handles drag the
mouse pointer to resize it.

(C) Images in a document can be added from different sources. These sources can be any
image file stored in a folder, clipart, picture gallery and from online source.

(D) Cropping is the removal of unwanted area from an image. Cropping is done from the
outer boundary of the image.

(A) The Decimal data type is used for column Price column.

(B) (i) SELECT Name, Price FROM Items WHERE Brand = “Doms”

(it) ALTER TABLE Items ADD Quantity integer

(iii) UPDATE Items SET price = price + 10 WHERE brand =" classmate”

(A) DBMS — Data Base Management System

RDBMS - Relational Data Base Management System

(B) A DBMS stores data in a file format and it does not support distributed tables or
databases, while an RDBMS data is stored in table format and it supports distributed
tables or databases, i.e., the data is physically distributed across the network.

(C) A table can have following types of keys — primary key, composite key, alternate key,
candidate key and foreign key.

(D) A primary key is a field which uniquely identifies the records in a table. A foreign key
is a field in relational database table that is primary key in another table. A foreign key is
used to establish relation between data in two tables.

(A) A dial up connection is a temporary connection setup between an ISP and a computer
to provide internet to the connected computer. It is established using a telephone line and
a modem device.

(B) The connection is established by dialling up the number provided by ISP. Broadband
connections are established using cable, digital subscriber line or a satellite. It is faster
than a dial up connection as the signal of a broadband connection can carry more data
onto your computer.

(IT SAMPLE PAPERS)-X (87)




(C) WiMax is a digital communication system that can provide broadband wireless access.
For this it requires a WiMax base station which is a tower similar to a cell phone tower.
Rather than using wires to establish a connection it uses microwave link for same.

(D) WiFi refers to the Wireless Fidelity, which lets you connect to the Internet without a
direct line form an ISP to your PC. it requires a broadband internet connection, a wireless
router and a computer with wireless internet card or adapter.

SAMPLE QUESTION PAPER-7

SECTION-A : OBJECTIVE TYPE QUESTIONS

Ans.1.

Ans.2.

Ans.3.

Ans.4.

Ans.5.

(i) (d) Phrases (@1) (b) Entrepreneur
(#ii) (c¢) Self-awareness (iv) (¢) Visual

(v) Sustainability (vi) (a) Bad

(i) (¢) Both (a) and (b) (ii) (b) Wireless
(iii) (a) Character (iv) (c¢) Cookies
(v) (a) Master (vi) (¢) What if
(i) (a) Protocols (it) (d) Flat

(#ii) (a) Grouping (iv) (a) Mbps

(v) Sticky

(vi) (c¢) Tables

@) (b) Cell (i) (d) Merge cell

(#ii) (b) Sum

(iv) (b) Primary

(v) (d) Top to bottom.

(i) (¢) Goal Seek

(i) (¢) Both (a) & (b) (i) document
(iii) (a) Mathematical

(@) (b) IRCTC

(v) (a) Graphical Interface

(vi) (¢) World Wide Web

SECTION-B : SUBJECTIVE TYPE QUESTIONS

Ans.6.

(88)

Being well versed with stress coping techniques, help people lead a healthy and happy
life. Properly managed stress prevents mental and physical illness. Stress management is
vital because it leads to following benefits:—

(1) Improves mood. (2) Boosts immune system.
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Ans.7.

Ans.8.

Ans.9.

Ans.10.

(3) Promotes long life.

(4) Leads to physical strength, which is vital for goal achievements.

(5) Complete mental and physical engagement for task accomplishment.

Based on functionality sentences can be classified mainly into four types.

(1) Declarative Sentence : Declarative sentence is an assertive sentence which simply
expresses an opinion/feeling or makes a statement, or describes things. This type of sentence
ends with a period or a full stop(.). For example, I am very happy today.

(2) Imperative Sentence : An imperative sentence makes a request or gives a command.
Imperative sentences usually end with a period or full stop. For example, please sit down.
(3) Interrogative Sentence : An interrogative sentence asks a question. Interrogative
sentences always end with a note of interrogation mark (?). For example, where are you
going?

(4) Exclamatory Sentence : An exclamatory sentence expresses overflow of emotions.
These emotions can be happiness, wonder, sorry, anger, etc. For example, what a day it
was!

An entrepreneur must have the following qualities:—

(1) Hard working — An entrepreneur must be very hard working to become successful.
Successful entrepreneurs adapt to the habit of hard work from a very early stage. The
ability of working hard makes it possible to move them to word the achievement of their
objectives.

(2) Optimistic — Successful entrepreneur should have a positive approach student life as
a whole. They should not be afraid of any adverse situation in business and should always
think optimistically about the future of the business in order to succeed.

The importance of Sustainable Development are :—

(1) Fulfill human needs — With increase in population and thereby increase in the
requirements of human beings, it becomes difficult to cater to human needs. The government
along with its citizens should implement policies which emphasizes minimal use of
renewable resources but at the same time using resources in a manner fulfills essential
human needs. In addition the natural resources will be conserved for future generations
also.

(2) Agricultural requirements — Population explosion also increases pressure on
agriculture to meet increased demand of food. Sustainable development focuses on
sustainable agricultural methods such as crop rotation, drip irrigation, organic farming
promote high yields while maintaining the integrity of the soil for increased agricultural
production.

As we know that computer is an electronic device we must take some precautions while
cleaning it and its components which are as under—

(1) Turn off and unplug the power cables of your computer before starting the cleaning
operation.

(2) Do not use any kind of spray cleaning fluid directly on the components of the computer
instead first spray the liquid on the cloth and then wipe the components.
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Ans.11.

Ans.12.

Ans.13.

Ans.14.

Ans.15.

Ans.16.

Ans.17.

(90)

The two terms associated with websites are—

(1) World Wide Web — W3 also known as web is a system of interlinked hypertext
documents accessed via the internet. WWW contains millions of websites that provide
information in the form of text, animations, pictures and videos.

(2) Web Browser — Web browser is a software, used to access information stored on web
servers. It is used to view websites and acts as an interface between the user and the
WWW.

The three advantages of a DBMS are as under-

(1) Database and its components can be created and modified as per requirement

(2) Powerful queries to retrieve data depending on the condition given by the user.

(3) Facilitates sharing of data, i.e., different users can use the same database to extract
data according to their needs.

The steps to create a new folder on C Drive are—

(1) Double click the computer icon available on your desktop.

(2) Select the C:\ drive, in which you want to create a new folder.

(3) A Window will open up showing files and folders in Local Disk C:\

(4) Click new folder on the toolbar.

(5) A new folder is created with the name New Folder highlighted.

(6) Type a name for the folder and press enter key or click anywhere in the window.

The two types of languages used for creating and manipulating the data in databases are-
(1) Data Manipulation Language (DML) — Data Manipulation Language (DML) is a

language that enables a user to access or manipulate data in a database. The DML commands
help users to query and manipulate data in the existing database.

(2) Data Manipulation Language (DML) is a language that enables a user to access or
manipulate data in a database. The DML commands help users to query and manipulate
data in the existing database. For, eg., SELECT.

A blog can be used to convey messages about personal events, worldwide happenings,
announcements, news, reviews etc. The topic of the blog can be anything from personal to
professional. A blogger can frequently update information related to his or her interest or
activities, express his ideas or opinions or share his knowledge by writing articles on
specific topics.

Paragraph styles controls the total appearance of the paragraph such as text alignment,
tabs, line spacing, borders and even character formatting. Whereas character styles affects
only the selected text within a paragraph, font and size of the text, or Bold, Italic and
Underline formats.

The data to be sent over the network is first broken up into small same sized pieces called
packets. Each and every packet along with data also contains sender’s address, receiver’s
address and the packet number.

Each packet is sent from one computer to another, until it reaches its destination. Each
computer on the network checks for the address and decides whether to keep it or let it go
to other computer. All the packets of the data may not take the same route to reach the
destination computer.
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At the destination, the packets are examined and assembled so that it is in a readable form.
If any packet is missing or damaged a message is sent to the sender asking for the packet
to be resent. This process continues until all packets have been received intact.

Once all the packets are received intact, the packets are reassembled into their original
form and becomes readable to the receiver. To your surprise, this all is done within seconds.

Ans.18. (1) Peer to Peer (P2P) architecture — Network in which all the computers have an equal
status is called peer to peer network. Generally, in such a network, each terminal has an
equally competent CPU.

(2) Client Server (C/S) architecture — Networks in which there is a powerful Central
computer with extra resources then the computers that are connected in the network. In
such a network, the main Central computer is known as server and other computers
connected to it in a network are called clients or nodes for workstations. Here the server is
responsible for providing all the information and resources to the client as per the request
made by the clients.

Ans.19. (A) CREATE TABLE EMPLOYEE (EMPID CHAR(4), EMPNAME VARCHAR(15),
DESIGN VARCHAR(20), SALARY DECIMAL)

(a) Primary Key uniquely identifies each row in a table.
(b) DDL commands — ALTER, DROP
DML commands — SELECT, INSERT

Ans.20. (a) =SUM(C4:C7)
(b) Sort (c) =MAX(D4:D7)
(d) =AVERAGE(C4:C7)

(e) For calculating Total price of all the products first we need to calculate Qty*Price per
piece in E column using the formula =C4*D4. And this formula is to be applied for all the
5 fruits. Than to find out the total amount we will use the following formula in cell ES.
=SUM(E4:E7)

Ans.21. The four data types available in OpenOffice base are:—

(a) Numeric Type — Numeric data types are used for describing numeric values for the
field used in the table of a database. Numeric data types in a database can be used for
storing information such as roll number, mobile number, etc.

(b) Alphanumeric Types — This data type allows to store alphanumeric values that is
characters as well as numbers and special symbols.

(c) Binary Types — Binary data types are used for storing data in binary form. This data
type can be used in a database for storing images, music files etc. In general, file of any
format can be stored in the database using this data type.

(d) Date/Time — Date/Time data types are used for storing date and time values in the field
who’s data type has been defined as Date/Time. This data type can be used in a database for
storing information such as date of birth, date of admission etc.
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SAMPLE QUESTION PAPER-8

SECTION-A : OBJECTIVE TYPE QUESTIONS

Ans.1.

Ans.2.

Ans.3.

Ans.4.

Ans.5.

@) (c) AVG (@) (c) Self-awareness
(#ii) (a) Innovative and open minded
(iv) (d) All of these ») (b) Ctrl + C

(vi) (¢) A person needs to have a big business to be called an entrepreneur.

(@) (b) Page
(i#i) (d) Another document

(@ii) (c¢) Cell reference @iv) (b) Table
(v) (d) Other options i) (a) LAN
(@) (@) Sum (@) (d) All of these

(#ii) (b) Describe data to be stored in each field
(iv) (a) Absolute

(v) (¢) Merged document

(vi) (b) Consolidate

() (d) All of these

(@) (d) Applying Sum function on the range.
(#ii) (b) Description

(iv) (d) ALTER TABLE

(v) (a) Macro

(vi) (@) HTTPS

(@) (b) Pictures

(@) (c¢) Create link for the required components using link to external data.
(#ii) (d) Composite

(@iv) (b) Sorting

(v) (@) Structured Query Language

(i) (d) All of these

SECTION-B : SUBJECTIVE TYPE QUESTIONS

Ans.6.

(92)

Myths regarding entrepreneurship are as follows:—

1. Every Business Idea Needs to be Unique or Special : A person can take an existing
idea in the market and do something different with it

2. A Person Needs a lot of Money to Start a Business : Entrepreneurship is about passion,
commitment and execution of idea. Money related problems can be solved by funding,

debts, loan, investors etc.
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Ans.7.

Ans.S.

Ans.9.

Ans.10.

Ans.11.

3. Entrepreneurs are Born Talented : Entrepreneurship starts with thinking of an idea
that you want to work on and making it different. A person who is self-aware and can
develop certain qualities can become an entrepreneur.

4. It is an Easy Way to Get Rich : Entrepreneurship does not mean making quick money.
It needs patience and time to make a business successful. Sometimes the venture results
into failure.

Organizational skills are the skills of using the available resources efficiently and effectively.
Being organized refers to managing time, energy and workspace well and completing all
the assigned tasks successfully. Organizational skills can vary depending on a particular
workplace and job title, but they typically involve maintaining an orderly workspace, meeting
deadlines and communicating well with the team.

Types of organizational skills are: Time management, Communication, Setting goals, Self-
motivation, Decision-making and Strategic planning.

SMART is an acronym in which M stands for Measurable which means that the goals
should have clear criteria for measuring the progress towards the achievement of goals.
The measure of an objective can be qualitative and quantitative. Measuring the goals,
makes it easier to track the progress.

Time management is important due to following benefits:—

It helps us to prioritize the tasks and allot required time to complete the task.

Properly scheduling the time helps in completing the work in due time.

Good time management gives us enough time to accomplish the tasks. This helps in reducing
the stress levels.

Timely accomplishment of tasks ensures the confidence and effciency of workforce.
Time management also improves the performance of workforce.

(A) Worms : Worms is a type of computer virus that does not modify the program like
virus does. Its main objective is to eat the system resources. It replicates itself more and
more and slows down the computer system.

(B) Trojan : A Trojan Horse is also a type of malware which uses fake names to mislead
users from its true intent and execute them. Trojan Horses generally gets installed on the
system as legitimate and useful software and gives unauthorised access and control of the
system to the hackers.

Web Server Web Client

A web server is a computer that serves | A web client is a user program thatconnects
web pages, web sites or web services. | to a server to access a service.

It receives requests from the client It sends requests to the web server and uses
computer, processes and sends the the services provided by the server.
output.
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Ans.12.

Ans.13.

Ans.14.

Ans.15.

Ans.16.

Ans.17.

(94)

(A) Magnifier : Magnifier is a tool of Windows that makes the part of computer screen or
an entire computer screen bigger. Using this tool the images and words can be seen better.
This tool is an accessibility feature for people with low vision impairments.

(B) Speech Recognition : Speech recognition is a tool of windows that identifies the
words spoken aloud and then convert them into readable text. People who are visually
impaired can use this tool to type text by speaking the words and sentences to the system.

When you are working on multiple worksheets, there would be a situation when you
would like to use data of one sheet into another. Linking will dynamically pull data from
one sheet to another. It will also update the data in your destination sheet whenever you
change the contents of a cell in your source sheet.

Flat File Database Relational Database

In flat file database all data is stored In relational database the data is stored

in a single table. in multiple tables.

There is no linking between data. The data in one table is linked to data

in another table.

Cannot avoid data redundancy. Data redundancy does not take place in
RDBMS

Clip art is a collection of pictures or images that can be imported into a document or
another program

websites that offers free clip arts:
https://www.mycutegraphics.com/

https://www.graphicsfactory.com/

Goal Seek Solver

Goal seek is used on single variable. Solver can solve equations that use

multiple variables.

It allows to vary the values only in It allows values to vary in 200 cells.

one cell.

(A) Macros are used to record the sequence of commands or keystrokes and save it for
later use. These automate the repetitive keystrokes and tasks and thus reduces time spent
in repetitive tasks and makes the work faster.

(B) To make changes in Macro he first needs to open the code of macro which he has
created using the Macro dialog box. It will display the code of Macro in the editing window,
where he can edit the code as needed.
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Ans.18.

Ans.19.

Ans.20.

(C) To use the macro code as a function the code is written between the clauses Function
and End Function.

E.g., Function Dept() Dept()= “Production”
End Function

(D) Calc internally creates equivalent commands for the recorded keystrokes and stores in
a programming code. These codes are stored inside Sub and End Sub clauses

(A) You can resize an image using sizing handles. If corner sizing handles are used, then
the image will be resized from both the dimensions. You can also resize the image from
the menu. While resizing the image from the menu click on “Keep image size” or “Keep
Ratio” option in word processor. This will maintain the ratio while changing the size of
the image.

(B) To place the image between text, you can use Text Wrapping features. There are many
options, e.g., behind. After, top/ bottom etc.To place the image in the center of the text
click on “Wrap through” option in Text Wrap settings.

(C) The image can be made transparent and kept in the background of the text. To perform
this you have to change the Color Mode of the image. By changing the Color Mode to
Watermark the image will be totally transparent that and will give the background effect
with text placed on it.

(D) The decorative text can be added using Text Art/ Word Art feature of the word processor.
This feature creates shadowed, skewed, rotated and stretched text in variant colours.

(A) A CHAR is a fixed length string data type, while VARCHAR is variable length string
data type. In CHAR data type. If the length of the string is less than fixed length then it is
padded with extra blanks while, in VARCHAR, If the length of the string is less than the
fixed length then it will store as it is without padded with blanks.

(B) (@) CREATE TABLE Library (MemID Char(7) PRIMARY KEY,

MemName VARCHAR(25), Book ID CHAR (7)

IssueDate DATE,

Return CHAR(1) DEFAULT “N”) ;

(b) INSERT INTO Library VALUES (“M101”, “Manya Gupta”, “B1151”, “2022-09-063,
N);

(c) UPDATE Library SET Return =Y” WHERE MemName= “Manya Gupta”;

(a) Form view can also be used to enter and modify records in database. It is an interactive
screen which allows user to work on single record at a time.

(b) To view records based on a particular condition, queries are used in database.

(c) To print the records, database provides Reports feature. Reports are the effective way
to print records in formal and formatted way.

(d) A query is a question which is defined and sent to the table or data source to retrieve
the data, whereas, a report is an organized and formatted view of the data retrieved by a
query. A report is generally a printed form of a query.
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Ans.21. (a) A secure connection is one that is designed to protect data sent between two computers

through the internet. It ensures the confidentiality of information and also that the data is
made accessible only to authorized users.

(b) A URL or web address that contains HTTPS and a pad lock sign is considered to be a
secured connection.

(c) @ Use strong passwords because strong passwords are not easy to hack and avoids
unauthorisd entry to your account.

e Control access to data and systems by giving authorization. This can be done by providing
login ids and password to authorized users.

e Put up a firewall. A firewall is a security wall in form of software that checks and
prevents malicious software to enter into system.

(d) A firewall is a software for network security that controls incoming and outgoing
network traffic and permits or blocks data packets based on security.

SAMPLE QUESTION PAPER-9

SECTION-A : OBJECTIVE TYPE QUESTIONS

Ans.1.

Ans.2.

Ans.3.

Ans.4.

(96)

(i) An (ii) (d) None of these
(iii) (a) Icons

(iv) (b) Ecological imbalance

(v) (d) All of these

(vi) (d) All of these

(@) (b) Numbering or bullet characters

(@) (c) Sheetl

(iii) (b)) MAN

(i) (b) What-if

) (a) True i) (a) ISP

(@) (b) Grouping (ii) (a) Chart

(@ii) (d) All of these (iv) (d) Record Macro
(v) (a) Symbols (vi) (b) Insert

@) (b) Page @@@) (b) Entry

(#i7) (b) Tools
(iv) Find and Replace feature can be used to search and replace the text.

(v) Flat (vi) Network
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Ans.5.

(@) (a) Merge Cells @i) (d) All of these
(@ii) (a) Data @iv) (b) Scenario
(v) (b) Duplicate values

(vi) (d) Both (a) and (b)

SECTION-B : SUBJECTIVE TYPE QUESTIONS

Ans.6.

Ans.7.

Ans.8.

Ans.9.

Cultural barriers arise due to ethnic, religious and social differences which often create
misunderstandings during the process of communication. These differences can also affect
ones perception and create confusion while understanding the message. For overcoming
cultural barriers both the parties involved in the communication must get familiar to each
other’s culture and respect their culture, religion and ethics.

Self motivation is a factor that develops an inner urge to do something, achieve goals
without any external pressure in an individual. It is an inbuilt life skill and may be developed
further as per requirement of an individual. Self motivation can be developed by—

Being positive and having positive attitude towards life.

Looking into past experiences where you have achieved success.
Entrepreneurship helps in promoting societal growth in the following manner-
e Increases economic growth

e Fosters creativity

e Stimulates innovation and efficiency

e Create jobs and gives employment opportunities

e Solves the problems of the society

e Encourages welfare of the society

e Fulfils ever growing and ever changing demands of the society

Two major causes of air pollution are —

Harmful gases emitted out mainly by factories and industries in the environment.

The fumes generated because of burning of fossil fuels.

Ans.10.Stress refers to a physical mental or emotional strain or tension which is unavoidable part

of one’s life. In fact, occasional and small amount of stress have a positive effect on one’s
life. Such stress helps to stretch ourselves to a new level. Stress well-managed can help one
view events and situations as challenges and contributes in the growth of an individual.
But high levels of stress, over prolonged periods, needs to be managed. Unmanaged stress
leads to anxiety and sorrow resulting in ill state of mental and physical health.

Ans.11. When the files are linked, then a change in the linked file gets updated in the destination

file. In the case of embedding, changes in the embedded file do not propagate to the
destination file. You need to manually make the changes in the destination file by double-
clicking the embedded file.

Yes embedding an object increases the size of the document.
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Two websites that offer free clipart are—
iCLIPART.com

Openclipart.com

GraphicsFactory.com

Clker.com

Ans.12.The various Electrical Safety Rules are as under-

Electrical equipments approved by a recognised organisation must only be used.
Damage and hazardous electrical equipment should be immediately replaced.
All old and workout and frayed switches and wires should be changed.

Heat emanating equipment should be kept away from the electrical equipment.

Take care that the outlets or circuits should not be overloaded.

Ans.13.Mail merge is a feature available within most data processing applications including writer.

Mail merge enables users to send a similar letter for document to multiple recipients. Mail
merge is basically a method of combining a list of recipients stored in a separate file called
data source with a main document having common message to be sent all the recipients.

Following are the steps involved in the process of mail merge—
Creating a main document.
Creating the data source.

Merging the data source with main document.

Ans.14. A template is a model that is used to create documents. Templates can contain anything that

regular document can contain, such as text, graphics a set of styles and user specified setup
information like measurement units, language, the default printer, customized toolbar and
menu bar.

All the documents in openoffice.org are based on templates. You can create a specific
template for any document type like text, spreadsheet, drawing, presentation. If you do not
specify template, when you create a new document, then that document is based on default
template for that type of document. If you do not specify a template, the Writer uses the
blank template for that type of document that is installed with OOo.

Ans.15.Form — A Form provides the user a systematic way of storing and modifying information

into the database. It is a graphical interface that let users to view, enter and change data
directly in the database objects like tables, views etc.

Report — Report is a database object that helps to display the data in a summarised manner.
In other words, it is used to generate the overall work outcome in a clear format.

Ans.16.Good practices for internet security :

(98)

¢ Do not share personal information

e Some websites require you to fill out forms containing field such as main gender wage
email ID School college company ATC. Be cautious while filling out such forms the search
and verify if it is a trustable website full stop your email id could be used by unauthorised
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users to send ID fake 100 unwanted emails to your friends or relatives by your name. Think
twice or thrice before providing information to any website and decide if it is really necessary.

¢ Keeping your username and password private

e Never save your username or password on your devices which are used in shared
environment such as cyber cafe, offices, labs etc. Browsers can also save your personal
data on the local computer that can be used by another person using the same computer

e Registering with website
Always read the privacy statement of policy whenever you register with outside, the
statement of policy will include information about how the website use personal data.

e Backup your data — always keep copy of your personal as well as important data in
additional media such as CDs pen drive etc. This could be helpful in situation when there
is a loss or corruption of data. Keep this copy of data away from unauthorised users.

Ans.17. A template is a model that is used to create documents. The steps for creating templates in
a document are —

Open a new or existing document of the type you want to make into a template i.e. text
document, spreadsheet, drawing, or presentation.

Add the content and style that you want.

From the Main Menu select File > Templates > Save as Template. The Save As Template
dialogue box opens up.

In the Template Name field, type the name for the template.
Choose the Category to which you want to assign the template. The category you choose
has no effect on the template itself, it is simply the folder in which you are saving the
template. Choosing an appropriate category make it easier to find the template when you
want to use it again.
For example, you might save a template under the Presentation category.
Click on Save button to save the template.

Ans.18. CREATE TABLE BOOK(BOOK ID Char(4), Bname Varchar(15), Author Varchar(20), Price
Decimal(5,2));
(a) BOOK ID is the Primary key because it contains unique values.

() ()
CHAR Data Type VARCHAR Data Type
Its full name is CHARACTER Its full name is VARIABLE CHARACTER
It stores values in fixed lengths and are VARCHAR stores values in variable length

padded with space characters to match the along with 1-byte or 2-byte length prefix

specified length and are not padded with any characters
It can hold a maximum of 255 characters. It can hold a maximum of 65,535 characters.
It uses static memory allocation. It uses dynamic memory allocation.
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Ans.19.

Ans.20.

Ans.21.

(i) DDL and DML

Data Definition Language (DDL) is a language that enables a user to create, modify and
work with the structure of the database whereas Data Manipulation Language (DML) is a
language that enables a user to access or manipulate data in a database. The DML commands
help users to query and manipulate data in the existing database.

(a) INSERT INTO FABRIC VALUES (“F005”, “Kurta”, “Woollen”,5);

(b) SELECT * FROM FABRIC where Disc>10;

(¢) SELECT * FROM FABRIC where Type="Woollen”;

(d) DELETE FROM FABRIC where FabricID="F003";

(a) =SUM(C4:C7)

(b) =MAX(D4:D7)

(¢) =AVERAGE(C4:C7)

(d) =SUM(E4:E7)

Blog — A blog is an easy to create website that allow users to share their thoughts with the
world over the internet. The word blog comes from the combination of words web and

log, where log is an official record of events or diary of information maintained on the
web.

Web Address — The web address is the information about the location of the webpage on
the server. Web address is also known as URL of the webpage.

Network — Computer network is a collection of computers and other hardware components
interconnected through a communication channel which allows sharing of resources and
information. Communication channel can be as simple as cables or as advanced as wireless
and satellite.

Web Browser — Web browser is a software, used to access information stored on web
servers. It is used to view websites and acts as an interface between the user and the
WWW.

SAMPLE QUESTION PAPER-10

SECTION-A : OBJECTIVE TYPE QUESTIONS

Ans.1.

Ans.2.

(100)

(i) (b) Bad Stress @ii) (d) All of these

(#ii) (a) taking responsibility for her mistakes

(iv) (b) Start menu

(v) (b) Spray a liquid before wiping the parts with cloth

(vi) (d) No higher authority

(@) (@) Drag and drop (ii) (b) Main text document.

(iii) (¢) Subtotal (@v) (c¢) Consisting separate tables of related data
(v) (¢) Not connected to a network (vi) (a) Blogging site
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Ans.3.

Ans.4.

Ans.5.

(i) (b) Embed (@@@) (c) Template
(#ii) (a) It supports data redundancy

(iv) (a) Flat database

(v) (d) USENET (vi) (¢) MS Office
(@) (d) All of these (@) (a) =Sales B1
(@ii) (c) Creating Links to the data from another sheet

(iv) (b) Candidate

(v) (d) Control over computers

(vi) (a) Book_number

(i) (a) Full address

(@) (c) CREATE

(#ii) (d) The field which stores unique value for each record
(iv) (b) Filter data from database based on some criteria
(v) (d) <sheetname> <col> <row>

(vi) (d) Prevents viruses and malicious software

SECTION-B : SUBJECTIVE TYPE QUESTIONS

Ans.6.

Ans.7.

Ans.8.

Ans.9.

Self-awareness refers to knowing about one’s self in terms of strengths, weaknesses,
abilities, likes, dislikes, attitude etc. knowing about one’s self is essential to understand
one’s own goals and areas of improvements regarding their weaknesses in achieving them.
It helps in managing the challenges and opportunities and strengthening their attitude and
abilities which increases confidence and finally helps you in making right decision.

SMART is an acronym in which ‘R’ stands for Realistic. It means that your goal should be
something that you want to achieve and can work towards it. The goal should be appropriate
for what you are trying to accomplish. An unrealistic goal is hard to achieve. Example of
an unrealistic goal would be building a muscular body in just 15 days. Example of realistic
goal would be — work out regularly and eat healthy to build a muscular body in next 4 to
6 months.

Stress is a part of everyday life. It can be helpful in some situations, e.g., it motivates you
to finish the assignment on time. But when experienced in excess or for a long period of
time, stress has the opposite effect. It can harm our emotional and physical health, and
limit our ability to function well. The stress may cause diseases like heart problems,
depression, sleeplessness, hypertension, ulcer, etc.

The files that you create using different types of applications are stored at default or
specified locations of your storage unit. Similarly, you can create folders to store your
files in them. To perform various operations on these files and folders you require a File
Explorer. So, a File Explorer is an application which is used to browse folders and files
stored in the computer. It allows the user to perform operations like copying, moving,
deleting and renaming these files and folders.
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Ans.10.

Ans.11.

Ans.12.

Ans.13.

Ans.14.

Ans.15.

(102)

Entrepreneurs come up with new ideas, concepts, and innovations and work on them for
the benefit of themselves and society. A successful entrepreneur becomes a role model for
the society and youngsters. Inspite of experiencing ups and downs, he develops his own
solutions to overcome his company’s flaws. This guides his employees and followers
towards the development of their start-ups under his supervision. As a result of their
experiences and guidance, youth are coming up with fresh ideas and solutions. Thus,
successful entrepreneur mentors and produces new entrepreneurs.

Advantages of networking are as follows:

Data Sharing : Networking allows sharing of same data among multiple users connected
to a common network.

Files Transfer : Users can send text files, spread sheets, documents, presentations, audio
files, video files, etc. to other users over the network.

Hardware Sharing : Network also allows its users to share hardware components such
as printers, scanners, hard disk etc. This helps in saving cost of resources.

Internet Access Sharing : A network is capable of sharing the internet connection among
other computers in a network. So instead of purchasing multiple Internet connection for
each computer only one connection is required.

(A) Toggle Keys : Toggle keys are the keys on the keyboard that is operated in the same
way but with opposite effect on successive occasions. E.g., Caps Lock is a toggle key,
pressed to switch between upper case and lower case alphabets.

(B) Sticky Keys : Sticky key an accessibility feature of Windows that assists users having
physical disabilities to reduce repetitive strain injury. It enables user to enter key
combinations by pressing keys is sequence rather than simultaneously. It helps users who
find difficulty in pressing shortcut key combinations.

Referential integrity refers to the relationship between two tables in a database. It means
that there must be a valid reference from a row in one table to another table. It ensures that
all data in a database remains consistent and up to date. It helps to prevent incorrect
records from being added, deleted, or modified. Lets us consider an example of database
with two tables, Customer and Orders. The Customer table consists of fields CustID and
CustName. Another table Order consists of fields OrderID, CustID and OrderDate. The
referential integrity states that the Customer ID (CustID) in the Order table must match a
valid CustID in the Customer table.

The overlapping documents mean that there are changes in common cells done by multiple
users. This gives rise to conflicts. If you try to save a document with conflicting changes,
the spreadsheet will show you a Resolve Conflicts dialog box. It allows you to resolve the
conflict by deciding which version of changes you want to keep. After resolving all the
conflicts you can save your document with decided changes.

A wrap setting is a feature of word processor that determines the relation between the text
and the graphic in a document. It is also known as text wrapping. A word processor ofters
different types of text wrapping options. You can place the text around the graphic or an
image in a way you want, using any one out of the given options.
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Ans.16. To add a link to an HTML table perform the following steps:
Open the sheet where you want to add a link.

Click the command Insert ’! Link to External Data.
Browse and select the file to be linked i.e. sales.html.

Ans.17. A. The Sharing of worksheet is required when multiple users wants to work on same set of
data. The users can view, edit or review the changes made in the shared worksheet.

B. All the users who are authorised to work on shared worksheet can see the changes
made in worksheet. They can also review and make comments on the changes done by
any user.

C. Following features are not available in sharing mode:

(i) Edit > Compare Document

(ii) Edit > Sheet > Move/Copy & Delete

(iii) Insert > Cells Shift Cells Down& Shift Cells Right Tools > Protect Document
(iv) Data > Define Range

(v) Data > Sort (vi) Data > Subtotals

D. The document in shared mode is opened in the same way as any other document. To
open a shared document click on File ’! Open.

Ans.18. A. She can use Crop feature of word processor to remove that unwanted part from the
image.
B. The drawing objects can be combined together by grouping. This feature will treat all

the separate objects as one and whatever functions are performed will be applied on all of
them.

C. Text Wrap feature can be used to keep the image between the text. The text is placed
around the image.

D. Yes the image can be placed in the background of the text by applying the Color Mode
as Watermark on it. The other way to make the image appear as watermark is by giving the
image transparent effect by changing the Transparency value.

Ans.19. A. TheStulD column can be declared as a primary key because it has unique values for
each record.

B. (i) SELECT Name, HName, Class FROM House ORDER BY HName ASC;
(if) UPDATE House SET HName = “Yellow” WHERE StulD = 11004;
(iii) DELETE FROM House WHERE StulD= 11006;

Ans.20. A. The roll umber field holds a unique roll number for every student so it is a primary key
field of the table. A primary key is a unique value that identifies a row in a table.

B. It is called a foreign key. When two tables are related by a common field and it is
declared as primary in one table then in another table it is known as foreign key. It identifies
a column or set of columns in one (referencing) table that refers to a column or set of
columns in another (referenced) table.
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Ans.21.

(104)

C. The primary key that consists of a combination of two or more fields or attributes is
known as composite key.

D. The field or a group of fields that have unique value for each record but is not selected
as a primary key is called alternate key. There can be only one primary key in a table.

A. Bills can be paid using online transaction or e-transaction facility. For availing this
facility, one would only need an internet connection and net banking facility which can be
availed by credit/ debit card or UPI ID.

B. Yes, she can also purchase medicines from another city by using online shopping facility.
There are many applications available that offers online purchase of medicines on
prescription basis.

C. Applications that provide facility of e-payment to pay your bills are: Paytm, Google
Pay, PhonePe etc.

Applications used of e-shopping are Amazon, Flipkart, Myntra, eBay etc. The applications
used specially for online purchasing of medicines are: PharmEasy, Netmeds, Truemeds
etc.

D. Online shopping means the process of selling and buying goods and services on Internet
platform. It is also known as e-shopping.
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